Copyright © 2000-2005 Definiens Imaging. All rights reserved. Made in Germany.

The information contained in this document is the exclusive property of Definiens Imaging. This work is protected under German copyright law and the copyright laws of the given countries of origin and applicable international laws, treaties and/or conventions. No part of this work may be reproduced in any form or by any means, electronic or mechanical, including photocopying or recording, or by any information storage or retrieval system, except as expressly permitted in writing to Definiens Imaging. All requests should be sent to the address written below.

The information contained in this document is subject to change without notice and should not be construed as a commitment by Definiens Imaging. Definiens Imaging assumes no responsibility for any errors that may appear in this document.

The software described in this document is furnished under a license and may only be used in accordance with the terms of such license.

eCognition is a protected software title.

The absence of a product or service name or logo belonging to Definiens Imaging anywhere in the text of this manual does not constitute a waiver of Definiens Imaging’s trademark or other intellectual property rights concerning that name or logo. All other products and brand names are trademarks and/or registered trademarks of their respective owners.

Authors
Martin Baatz, Ursula Benz, Seyed Dehghani, Markus Heynen, Astrid Höltje, Peter Hofmann, Iris Lingenfelder, Matthias Mimler, Malte Sohlbach, Michaela Weber, Gregor Willhauck

Contact
Definiens Imaging GmbH
Trappentreustrasse 1
80339 München
Germany

Tel. +49-89-231180-0
Fax +49-89-231180-90
eMail: ecognition@definiens-imaging.com
Homepage: www.definiens-imaging.com
INTRODUCING ECOCOGNITION ELEMENTS

Introducing eCognition Elements ................................................................. 4
Welcome to eCognition Elements’ world of object oriented image analysis! .... 5
How to use this user guide ......................................................................... 5
Background ............................................................................................... 5
Gaps between the new generation of remote sensing systems and GIS .... 5
Welcome to eCognition Elements’ world of object oriented image analysis!

eCognition follows an object oriented approach towards image analysis. It provides you with a whole bundle of innovative features and techniques for a fast image analysis. You will be surprised by the speed and the additional information that can be extracted from image data after segmenting it into image objects and by the possibilities to handle even textured or low contrast data, such as very high resolution (VHR), airborne, or radar data.

The concept behind eCognition is that important information necessary to interpret an image is not represented in single pixels, but in meaningful image objects and their mutual relationships. The basic difference, especially when compared to pixel-based procedures, is that eCognition does not classify single pixels, but rather image objects which are extracted in a previous image segmentation step.

To turn this into action, eCognition offers a whole set of tools:

Using a patented segmentation algorithm, eCognition allows homogeneous image object extraction in any desired resolution. This entails the simultaneous representation of image information on different scales. The segmentation procedure detects local contrasts and was especially developed to work even on highly textured data, such as VHR or radar imagery. Based on image objects, the problem of multisource data fusion is tackled by enabling parallel evaluation of image information of arbitrary source. eCognition features a set of interfaces which make information about image objects, features and classification transparent and accessible. The classification process is based on a nearest neighbor classifier on a fuzzy logic basis. This allows the integration of different object features such as spectral values, shape, or local contrast for classification.

Combining these features allows you to address image analysis tasks that have not been accessible until now. This powerful and universal method for object oriented image analysis significantly extends the range of image analysis applications and turns remote sensing data into more accurately classified geographic information for various purposes.

How to use this user guide

We recommend that you start with the chapter “Take the Plunge.” It guides you through an entire example exercise. You do not need any previous knowledge of eCognition for this chapter. The purpose is to go through an example step by step to get a first impression of how to work with eCognition, its look and feel.

Find out about the different functionalities of eCognition and its characteristics in a brief eCognition overview below.

Following that, we recommend that you work through the “Guided Tours” for an introduction to the handling of the software by means of examples. Take the time to work through this guided tour carefully. It covers practically all important features of the software and a typical approach for image analysis. Have in mind, however, that the multitude of applications possible with eCognition cannot all be covered by the guided tour!

Have a look at the “Concepts & Methods” parallel to the “Guided Tours” to learn about the background and procedures used in eCognition. You will find themes on “what is object-oriented image analysis?” multiresolution segmentation, fuzzy classification, and a systematic overview of all features used for the classification of image objects. In addition, theoretical concepts are described.

The chapter “Functional Guide” shows you in detail how to use eCognition, in all its different functionalities. Important steps for an image analysis are described, e.g., importing and exporting raster data, multiresolution segmentation, classification, and important strategies for the use of eCognition.

Use the chapter “User Interface” in parallel to both the “Functional Guide” and the “Concepts & Methods” chapters. It provides a description of eCognition’s tool bar, menus and dialogs. Similar information is given in the tool tips in the software.

You can find some basic rules for the handling of eCognition as well as helpful advice or solutions to problems you might be confronted with under “Strategies & FAQs.”

The chapter “Index” is a table of contents comprised of the structure of this user guide, its main chapters and headings.

You can find important eCognition related terms and key words in alphabetical order with a short explanation and hyperlinks to a more detailed description in the chapter “Glossary.” Links placed throughout the user guide make it easier to navigate within and between chapters and serve as a dictionary of crucial features, or simply to refresh your memory.
Background

Gaps between the new generation of remote sensing systems and GIS

For years, many efforts have been made to develop automated procedures for updating GIS databases using remote sensing image data. However, the situation is still characterized by a considerable operational gap.

An increasing amount of very high resolution imagery (VHR) of astonishing quality provided by new digital airborne and space-borne sources has entered the remote sensing market. It is characterized by high user interpretability, rich information content, sharpness, accuracy, high image clarity and integrity. Although this kind of data diminishes the problem of allocating individual pixels to their most likely class, their rich information content dramatically aggravates the process of pixel labeling.

At the same time, the GIS market is asking for plug-and-play, ready-to-use products from these sources. Polygons representing objects of interest with correct labeling are needed to update GIS databases.

However, in many cases such objects are heterogeneous—shadowed areas, for instance, cause ambiguities—and a lot of knowledge and local context information is needed to extract real world objects properly.

In contrast to the strong need for automated technologies, available state-of-the-art image analysis procedures—basically pixel-based approaches—are limited. Typically, they have considerable difficulties dealing with the rich information content of VHR data; they produce a characteristic, inconsistent salt-and-pepper classification, and they are far from being capable of extracting objects of interest. Therefore, the vast majority of operational projects can be realized only by means of massive human interaction. The visual interpretation of an IKONOS 11 km x 11 km scene can take several days, for instance. The production of geoinformation from remote sensing image data is therefore still expensive.

The existing constraints on automated data interpretation are so profound that an efficient integration of remote sensing and GIS is still a matter for research and development. The automated allocation and extraction of real world geographic objects from high resolution remotely sensed data is the central challenge for both the remote sensing and the GIS communities within the next few years.

In this situation eCognition with its object oriented approach is opening new paths and perspectives. Find out with the help of this guide how eCognition supports you in extracting geoinformation from remote sensing data.

eCognition overview

eCognition is based on an object oriented approach to image analysis. It is explicitly designed to work even on VHR or radar imagery and includes the option to develop knowledge bases for elaborate classification of land use. The basic difference to pixel-based procedures is that eCognition does not classify single pixels, but rather image object primitives that are extracted in a previous image segmentation step. For this purpose eCognition features multiresolution segmentation, a patented procedure for image object extraction. It allows the segmentation of an image into a network of homogeneous image regions at any chosen resolution. These image object primitives represent image information in an abstracted form. Serving as building blocks and information carriers for subsequent classification, they offer some basic advantages:

- Beyond purely spectral information, image objects contain a lot of additional attributes which can be used for classification: shape, texture and—operating over the network—a whole set of relational information.
- Multiresolution segmentation separates adjacent regions in an image as long as they are significantly contrasted—even when the regions themselves are characterized by a certain texture or noise. Thus, even textured image data can be analyzed.
- Each classification task has its specific scale. Only image objects of an appropriate resolution permit analysis of meaningful contextual information. Multiresolution segmentation provides the possibility to easily adapt image object resolution to specific requirements, data and tasks.
- Homogeneous image objects provide a significantly increased signal-to-noise ratio compared to single pixels as to the attributes to be used for classification. Thus, independent of the multitude of additional information, the classification is more robust.
- Segmentation drastically reduces the sheer number of units to be handled for classification. Even if a lot of intelligence is applied to the analysis of each single image object, the classification works relatively fast.
- Using the possibility to produce image objects in different resolutions, a project can contain a hierarchical network with different object levels of different resolutions. This structure represents image information on different scales simultaneously. Thus, different object levels can be analyzed in relation to each other.
- The object oriented approach which first extracts homogeneous regions and then classifies them avoids the annoying salt-and-pepper effect of the more or less spatially finely distributed classification results which are typical of pixel-based analysis.

Beside the production and handling of networked image objects, the second key domain of eCognition’s engine is its fuzzy classification system, which makes it possible to use the full advantages of the information contained in image objects and their mutual relations. It supports, a very simple, rapid classification using a fuzzy nearest neighbor classifier. Individual image objects are marked as typical representatives of a class, and then the rest of the scene is classified (“click and classify!”).
Segmentation

Basic to eCognition’s procedures is multiresolution segmentation, a patented technique for image object extraction. It was developed to extract image objects at different optional resolutions (fine or coarse structures) in high quality. This technique has been adapted to finding image objects even in textured data, such as SAR images, satellite data of high resolution, or airborne data. It provides the possibility to easily adapt the extraction of meaningful image object primitives to specific tasks and image data.

The segmentation can be used to construct a hierarchical network of image objects. Each level in this hierarchical network is produced by a single segmentation run. The hierarchical structure represents the information of the image data at different resolutions simultaneously. Fine objects are sub-objects of coarser structures. Thus, each object “knows” its context, its neighborhood and its sub-objects. Operating on this network, interrelations between objects can be defined, e.g., “relative border length to brighter neighbors, or spectral mean difference to super-object” for utilizing this additional and often essential information.

Classification

eCognition supports a supervised classification technique to train and build up a knowledge base for the classification of image objects. The frame of eCognition’s knowledge base for the analysis and classification of image objects is the so-called class hierarchy. It contains all classes of a classification scheme. The classes can be grouped in a hierarchical manner allowing the passing down of class descriptions to child classes on the one hand, and meaningful semantic grouping of classes on the other. This simple hierarchical grouping offers an astonishing range for the formulation of different analysis strategies.

Classification is conducted by fuzzy logic. Fuzzy classification delivers not only the assignment of one class to an image object, but the degree of assignment to all considered classes. The strategies for class assignment are transparent and therefore easier to adapt than if neural networks were being applied. Fuzzy logic even supports the combining of very different kinds of features within one class description by means of different logical operations.

Class descriptions are performed using a fuzzy approach of nearest neighbor on object features, defined by membership functions. It supports an easy click and classify approach based on marking typical objects as representative samples.

Features for classification

In eCognition, features for classification are computed based on image objects, not on single pixels. Therefore, classification can address an astonishingly broad spectrum of different kinds of information. Beyond spectral information there is shape information, texture information and—operating over the network of image objects—many different relational features. For each feature this information is computed per object considering its actual shape and size. Thus, the typical failures of filter operations, especially on borders between different types of areas, are avoided.

Besides, eCognition contains features for object oriented texture analysis. By regarding the sub-objects of an image object, average attributes such as spectral standard deviation, contrast, or shape can be analyzed. As the resolution of sub objects can easily be adapted to represent specific texture structures, object oriented texture analysis with eCognition is a powerful tool.

Information about image objects and classification

Complimentary to the bundle of attributes on which classification can act and the possibility of using contextual information, eCognition provides a whole set of different interfaces for detailed information about image objects, features and classification. Different tools visualize the attributes of image objects, indicating which features could be used to describe and distinguish classes. The image object information interface supports the detailed evaluation of each single image objects for any arbitrary class, allowing comprehensive understanding and adaptation of the entire rule base.

Multisource data fusion

eCognition offers a variety of possibilities for simultaneously using different data types for analysis. In the segmentation process, different layers can be weighted as to their suitability for shaping resulting image objects. The knowledge base for classification allows the highly specific use of information from given image data.

Given these options, a multitude of methods are feasible. Objects resulting from a segmentation of one layer can be evaluated using information from another or several other image layers. Differently scaled image objects can be created from image layers of different resolutions. Thus, information from different layers can be represented on different levels in the image object hierarchy, allowing for the evaluation of the different information layers in relation to each other.
Vectorization

eCognition allows the automated extraction of polygons based on image objects. The polygons can be used for the vector export of results. After vectorization, eCognition simultaneously holds image objects in raster and vector representations.

Statistics and accuracy assessment

After classification, an elaborate statistic tool allows analysis of the network of classified image objects. For all objects of a specific class, a statistic can be produced concerning any chosen attribute. The statistic tool supports the direct extraction of geoinformation from a scene. The results of a statistical analysis can therefore be exported.

An important issue is the detailed analysis of accuracy after classification. eCognition comes with different options for computing user's, producer's and overall accuracies. Each object's membership to a class can be visualized.

Export of results

eCognition comes with different options for exporting results. To update a GIS database, the classified image objects in the scene can be exported in vectorized format as points, lines or polygons with an attached attribute list. Beside the classification, this list can contain any chosen property for each image object. A similar option is the export of image objects by means of a thematic raster layer together with an attached attribute list.

Instead of exporting the whole structure of image objects, in many cases it might be enough to directly export statistical results or objects of selected classes, since they already contain the geoinformation of interest.

A further possibility is to export the whole scene as an image layer using the current view settings.

Concluding remark

The object oriented approach to image analysis differs from pixel-based methods in many aspects. As a result, due to the image segmentation and object creation, there is less remote sensing expert knowledge necessary to analyse an image. Moreover, image classification becomes much faster and more transparent. eCognition's fuzzy concepts make the classification assessment much easier and more understandable.

eCognition Elements is made for image analysis and not for image processing. Therefore, it does not contain procedures which allow modification of image data. If that is what you need, e.g., for preprocessing your image data, we refer you to one of the various software solutions available for image processing.

And now, enjoy your work with eCognition!
2 INSTALLING ECOCOGNITION ELEMENTS

Installing eCognition with a hardlock ................................................................. 5
Installing eCognition with a local hardlock ......................................................... 5
Installing eCognition with a server hardlock ...................................................... 6

The Hardlock Utility Software .............................................................................. 7
Initialize Hardlock Server module with alf file .................................................... 7
Export license information ..................................................................................... 7
Update License ........................................................................................................ 7
Server Hardlock, Update from clipboard .............................................................. 8
Server Hardlock, Update by File ............................................................................ 9
Generate Report ....................................................................................................... 10
Diagnostix ................................................................................................................ 10
About ....................................................................................................................... 11

The Aladdin DiagnostiX Tool ................................................................................. 12
Checking for a Hardlock Module ......................................................................... 12
Creating reports ..................................................................................................... 12
Setting environment variables ............................................................................ 13
Environment Variables ........................................................................................ 13

Hardlock and License Troubleshooting ............................................................... 16
Common errors ...................................................................................................... 16
Installing eCognition with a hardlock

The software is protected by hardlock keys, which are connected either to the parallel, serial or USB port of the computer. There are two different types of keys: local hardlocks and server hardlocks. Depending on the type of hardlock, different installation configurations are necessary.

Single License Hardlock LPT
connection to either parallel or serial port for single licenses

Single License Hardlock USB
connection to USB port for single licenses

Server License Hardlock LPT
connection to parallel port for network licenses up to 250 users

Server License Hardlock USB
connection to USB port for network licenses up to 250 users

Installing eCognition with a local hardlock

A local hardlock provides a license for one single eCognition system. Just install the eCognition software and the hardlock driver software is installed automatically.

For the installation you need:

- The hardlock
- The eCognition software CD.

The image shows the recommended installation configuration for eCognition with a single hardlock.

Note: Attach the hardlock to the parallel or USB port before running the eCognition software.
Installing eCognition with a server hardlock

The server hardlock provides a floating license with up to 250 licenses to any computer in the network where the server hardlock is installed.

For a server hardlock there are two basic setup options. Option one is to install only the hardlock server software, the other option is to install both the eCognition software as well as the hardlock server.

For both types of installation you need:

- the server hardlock
- the eCognition software CD
- the *.alf license file, which is provided to you via email or attached to the software package on a floppy disk

**Note:** The installation of the Hardlock Server software is only mandatory on the PC where the Server Hardlock is plugged on.

Installing only the Hardlock Server Software

In case you want the license to be provided by a dedicated license server you need to install only the hardlock server software. For this purpose deactivate all items in the installation feature selection and select the items “Hardlock Driver”, “Hardlock Server” and „Hardlock Server Service” only.

Then follow the installation instructions. The picture to the right shows the setup option which installs only the hardlock server software.

**Note:** Attach the hardlock to the parallel or USB port before installing the eCognition software.

Installing the Hardlock Server and eCognition Software

If you want the license to be provided by a license server, which is also used to run eCognition, you need to install the eCognition software components and the hardlock server software. Select the features as shown in the image below and follow the installation instructions.

The picture to the right shows the setup option which installs the hardlock server software and eCognition.

**Note:** Attach the hardlock to the parallel or USB port before installing the eCognition software.
The Hardlock Utility Software

The Hardlock Utility software can be found in the start menu section of eCognition. It contains the most important license utility tools to manage and troubleshoot eCognition licenses. Select one of the subordinate options on the left side of the window.

Initialize Hardlock Server module with alf file

This option is used to initialize or update your Hardlock Server service with an alf file. The alf file is crucial to run eCognition with a server Hardlock since it provides additional license information. This has not to be done if you use a Local Hardlock.

You have to initialize or update your Hardlock Server module after installing it for the first time or if you got a new *.alf file from your License Contact Person (e.g. in case the old one is corrupt).

To initialize or update your Hardlock Server service, select “License Management > Initialize HL Server“ and browse to the alf file which was provided to you via e-mail or attached to the software package on a floppy disk. Press “Save” to update or initialize the alf file.

The alf file will be simply copied to your system32 folder. This will also rename all previously present *.alf files from your system32 folder to *.old_alf to prevent problems with old or corrupt alf files.

Export license information

To order license updates, you have to provide your eCognition license contact person with the license information on your computer or network.

Select “license management > Export license information“.

Local Hardlock

Use the option Local hardlock in case you have a hardlock locally connected to your PC.

Choose a filename and press “Save“ to store your license information in a file.
Server Hardlock

Use the option “Server Hardlock” in case you want to get the license information of a server hardlock. The server hardlock is detected automatically. If the hardlock is not found automatically use the Advanced Settings to manually insert the IP-Address or the name of the PC where the Hardlock Server is installed.

Choose a filename and press “Save” to store your license information in a file.

Send the produced *.ctv file to your license contact person.

Update License

When a license update is provided by your eCognition license contact person this is either done using an *.exe file, a *.vtc file or a vtc block. The *.exe file can be executed directly. To apply the *.vtc file, use the option “License Management > Update License” of the Hardlock Utility.

Local Hardlock, Update from Clipboard

To update the license of a Hardlock locally connected to this PC using a vtc block select the option “Local hardlock > Update from clipboard”.

Paste the license string from an update email sent to you by your eCognition license contact person into the “License key window” (see below) and press “Import”.

After pressing Import your license should be updated.

This action will only work for hardlocks locally connected to this PC.
Local Hardlock, Update by File

To update the license of a hardlock locally connected to this PC using a *.vtc select the option “Local hardlock > Update by file”.

Browse to the *.vtc file sent to you by your eCognition license contact person and press “Import”.

After pressing Import your license should be updated.

This action will only work for hardlocks locally connected to this PC.

Server Hardlock, Update from clipboard

To update the license of a server hardlock using a *.vtc select the option “Server hardlock > Update from clipboard.”

Paste the license string from an update email sent to you by your license contact person into the License key window (see below) and press “Import”.

The server hardlock is detected automatically. If the hardlock is not found automatically use the “Advanced Settings...” to manually insert the IP-Address or the name of the computer the Hardlock Server is installed on.

After pressing “Import” your license should be updated.

This action will only work for server hardlocks.
Server Hardlock, Update by File

To update the license of a server hardlock using a *.vtc select the option “Server hardlock > Update by file”.

Browse to the file sent to you by your license contact person and press “Import”.

The server hardlock is detected automatically. If the hardlock is not found automatically use the “Advanced Settings...” to manually insert the IP-Address or the name of the license server.

After pressing “Import” your license should be updated.

This action will only work for server hardlocks.

Generate Report

Reports are used to access the licence status of the hardlock.

Select “Generate Report”.

Local Hardlock

Use the option “Local hardlock” in case you have a hardlock locally connected to your PC. This function creates a report of a hardlock locally connected to your PC.

Press “Create” to create the report.

The result is shown in the report window.

By pressing “Save” the report is saved to a text file. If you contact the eCognition Support you might be asked to send this file.
Server Hardlock

To update create a report of the license information of a server hardlock select the option “Server hardlock”. The server hardlock is detected automatically. If the hardlock is not found automatically use the “Advanced Settings” to manually insert the IP-Address or the name of the license server.

Press “Create” to create the report. The result is shown in the report window.

By pressing “Save” the report is saved to a text file. If you contact the eCognition Support you might be asked to send this file.

Diagnostix

To provide detailed system information and setting of environment variables, a separate tool called Diagnostix is used. Press “Starting Aladdin Diagnostix” to start the diagnostics tool.

About

Here you will find information about the Version of the Hardlock Utility Software. This can be useful if you when communicating with your eCognition license contact person.
The Aladdin DiagnostiX Tool

The Aladdin DiagnostiX utility collects relevant information of your system and of your Hardlock module. This information will help you and the eCognition support team to solve problems you may encounter when using eCognition. For installation and troubleshooting purposes, the following functions are required:

- Checking for a Hardlock module.
- Creating reports on Aladdin devices and their environment.
- Defining Hardlock environment settings.
- Viewing System Data.

Checking for a Hardlock Module

From the DiagnostiX tools pane (left) select “Hardlock”. The Check Hardlock screen appears in the main pane (right). All Hardlock access results are summarized and tabulated in the Key Access History.

To check a Hardlock module

1. Select the Access Mode type.
   - To check the Hardlock module on the local machine select local (parallel, PC-Card, USB).
   - To check the Hardlock module on the network select remote (HL-Server).
2. Enter the 21736 into the module address field
3. Check “Save memory” to report file if you want data in Hardlock module memory to be included to the generated report file.
4. Click “Check Key”.

Details for the access are displayed in the Key Access History pane.

Creating reports

The function “Create Report” creates report of the PC, Hardlock and network settings to allow support to identify possible setup problems which may occur during installation. To create a report, select „Create Report“ from the Edit menu. A message box will appear to indicate that the report has been successfully created.

**Note:** Check the Hardlock modules as described in chapter „Checking for a hardlock module“ before you create a report. Check both remote and local on a PC where the Hardlock Server is installed and on a PC where only eCognition is installed.

The zip file can then be sent to the eCognition support team.
Setting environment variables

In some cases environment variables need to be set for the hardlock software. Such cases can be usage of a server hardlock locally, hardlocks in complex networks, slow network connections etc.

Defining Hardlock Environment settings:

1. Change to the „Hardlock Environment“ part of the DiagnostiX tool.

2. Select either „System“ or „Current user“ in the Hardlock Environment screen. Selecting „Current User“ implies that setting modifications will only apply to the current user on the system. Only users with the required administrative rights will be able to modify System settings.

3. Set any of the following parameters:
   - HLS_WAIT
   - HLS_WAITTICKS
   - HLS_RETRIES
   - HLS_IPADDR
   - HL_LICENSEDIR
   - HL_SEARCH.

For further details on the parameters see below.

4. To activate environment settings parameters, click Confirm Changes.

5. To restore current settings click Reload Settings.

Environment Variables

**HLS_WAIT**
Use this parameter to set the timeout in milliseconds for the 32-bit API. Use a higher value if you work in a slow network

Syntax: HLS_WAIT

Range: 20-3000

Default: 1000

**HLS_WAITTICKS**
Use this parameter to set the timeout for the 16-bit API. Use a higher value if you work in a slow network

Syntax: HLS_WAITTICKS

Range: 1-999

Default: 2

**HLS_RETRIES**
Use this parameter to set the number of retries before timeout. Use a higher value if you have a bad network connection or an overloaded network.

Syntax: HLS_RETRIES

Range: 2-30

Default: 5
2 - Installing eCognition Elements

**HLS_IPADDR**

Use this parameter to set the server IP address. Use this parameter if a client cannot find the PC where the Hardlock Server is installed.

Syntax: HLS_IPADDR
Range: IP address
Default: None

Setting the parameter:

1. Click the corresponding button for this parameter in the Hardlock Environment screen. The HLS_IPADDR String Editor opens.
2. From the Available Tokens list select a token and use the >> button to move a token to your Used token list. Your selection appears in the list as well as the HLS_IPADDR current parameter field.
3. To define your own tokens, click User Defined. Enter the token in the field provided. Click OK. The token you have defined should appear in the Used Token list as well as the HLS_IPADDR current parameter field.
4. Review your selections. To remove an item from the Used Token list, select the token and use the << button.
5. To save your settings, and close the String Editor, click OK. Your selections appear in the HLS_IPADDR field in the Hardlock Environment screen.
6. To clear the modified values for this parameter, click Clear.

**HL_LICENSEDIR**

Use this parameter to direct a Server Hardlock to where the Aladdin License Files (ALFs) are stored. This function is needed when you want to use a server hardlock locally. The default location of the *.alf file is \C:WINDOWS\system32\.

Syntax: HL_LICENSEDIR
Range: An address on the local drive
Default: None

**Note:** This variable is set by default while the installation routine of Hardlock Server software.

Setting the parameter:

1. Click the corresponding button. A separate window opens.
2. Point the path to or enter the name of the license directory. Click OK. The window closes and name of the directory appears in the HL_LICENSEDIR field.
3. To clear any modified values for this parameter, click Clear.

**HL_SEARCH**

Use this parameter to determine where to search for the Hardlock.

Syntax: HL_SEARCH
Range: Parallel, serial port, USB, IP/IPX/NETBIOS
Default: None

Setting the parameter:

1. Click the corresponding button for this parameter in the Hardlock Environment screen. The HL_SEARCH String Editor opens.
2. From the Available Tokens list select a token and use the >> button to move a token to your Used token list. Your selection appears in the list as well as the HL_SEARCH current parameter field.
3. To define your own tokens, click User Defined. Enter the token in the field provided. Click OK. The token you have defined should appear in the Used Token list as well as the HL-SEARCH current parameter field.

4. Review your selections. To remove an item from the Used Token list, select the token and use the << button.

5. To save your settings, and close the String Editor, click OK. Your selections appear in the HL_SEARCH field in the Hardlock Environment screen.

6. To clear the modified values for this parameter, click Clear.
Hardlock and License Troubleshooting

When you start eCognition, a valid license is sought. A connection to the hardlock server is established and a license request is sent to the hardlock server. The Hardlock Server software package is installed as a Windows service on the server that is listening for these requests. In this process error may happen.

Please read this – It saves time!

The first thing you should do when encountering problems with the hardlock is to create report files using the DiagnostiX tool and send them to

support.ecognition@definiens.com

along with a short description of the problem you encounter. If you have a local hardlock, a local report is sufficient. If you have a server hardlock create local and remote tests on both the server PC and the client PC. Please make sure that hardlock checks are included in the tests. For details see „checking for a hardlock module“ and „creating reports“. In addition screenshots of the „Test Module“ function of the HLT est utility are most helpful.

Below is a list of various errors which may be encountered:

Common errors

Error 7: Hardlock not found:
This can have different reasons. The most obvious is that no hardlock is connected, or - in the case of a serial port hardlock – that hardlocks of other software products create conflicts. In some cases this error is also displayed when the hardlock has expired. Clarity can be obtained by executing the hardlock utility and checking the status. If more than one hardlock is used, the eCognition hardlock should be connected first to the port. Laptops sometimes have special settings for their parallel ports or even have them disabled. This can also lead to a hardlock not being detected.

Error: ALF License file not found
This error occurs in connection with server hardlocks. It indicates that either the *.alf file is not present or the hardlock can not access it. To solve this problem try adding the hardlock to the server (see „Installing Hardlock Server“). The second possible reason is that you are trying to work locally with a server hardlock. To allow this the environment variable HL_Licensedir needs to be set. (see „environment variables“).

Error 28: Date fake detected:
To prevent the user from changing the date and time settings of his computer and thereby avoiding the expiry date of a hardlock, the date and time settings are checked. If they are changed in between two sessions, the hardlock is disabled. Therefore, it is advisable to check whether the date settings of two computers are identical before transferring the hardlock from one computer to another.

Error 37: Expiry date reached
The hardlock needs to be updated. You can request an update executable at license.ecognition@definiens.com. It can be sent via email. Please always specify the serial number of your hardlock.

Error 1009: Cannot open hardlock driver:
Either the driver is not installed at all or a wrong driver is installed. Make sure to install the appropriate driver.

Error installing hardlock driver:
This can happen if a driver which is not suited for the operating system is used, or more likely if the user has no administration rights to the computer.
3 TAKE THE PLUNGE

Getting a first glimpse of eCognition Elements

Rather than going into too much detail too soon, we recommend that you start with this chapter rather than the theoretical chapters that follow. Work through “Take the Plunge” first to get a feel for eCognition’s Elements user interface and its most basic features.

Since eCognition is based on a new approach to image analysis, taking this short trip may sometimes make you feel as if you have been “thrown into the deep end.” This is just what is intended. The purpose of this chapter is to go through an example step by step without having to worry about the whys and wherefores of your actions. The goal is to get a first impression of how to work with eCognition. All features of eCognition will be explained systematically later on.

The first example you will work on is a subset of a LANDSAT TM scene. It shows the town of Dessau on the Elbe River in Saxony-Anhalt, Germany. The goal is to classify the image so that a thematic map of the area can be created.

![Image of Dessau scene](image_url)

Creating a new project and loading the raster data

1. From the “Project” menu choose “New...” or click ![New Project](image_url) in the tool bar.

2. Navigate to the directory where you have saved the sample data to.*

3. Select the following image files and click “Open.”
   - dessau_blue.bmp
   - dessau_fir.bmp
   - dessau_green.bmp
   - dessau_mir.bmp
   - dessau_nir.bmp
   - dessau_red.bmp
   - dessau_term.bmp

4. Change the order of the layers by marking them and by using the arrows to the left of the “Sort” button.

5. Click “Create.”

The new project is now being started and raster layers are being imported.

*Visit www.definiens-imaging.com/central/index.htm to download the sample data or check your Trial Version CD-ROM.
Changing the color composition of the displayed image

1. Select “Layer Mixing...” from the “View” menu or click in the tool bar to open the layer mixing dialog.
2. Select “Histogram” under “Equalizing” to apply a histogram stretch.
3. Choose “six layer mix” as “Presets.”
4. Click “OK.”

Creating image objects

Now that you have created a project, you can move on to making your first object oriented image analysis. Object oriented processing of image information is the main feature of eCognition. For this reason, the first step in eCognition is always to extract image object primitives, which will become the building blocks for subsequent classifications. You will now produce such image objects with multiresolution segmentation. Multiresolution implies that it is possible to generate image objects at any chosen resolution.

1. From the “Image Objects” menu choose “Multiresolution Segmentation...” or click in the tool bar.
2. Weight “dessau_blue.bmp” and “dessau_term.bmp” 0 in the field “Edit weights.” They will not be considered for segmentation.
3. Insert 10 in the field “Scale Parameter.”
4. Choose “Normal” in the field “Segmentation Mode.”
5. Weight “Shape” with 0.3 in the section “Composition of homogeneity criterion” and “Compactness” vs. “Smoothness” at 0.5.
6. Ensure that “Diagonal pixel neighborhood” is disabled.
7. Click “Start” to start the segmentation process.

When the segmentation process is finished, there are different ways to display the image objects. By default the image objects are transparent and highlighted only on mouse-click. To view the image objects colored in their mean value, click the icon or change the view settings for image data from “Pixel” to “Object mean” in the „View Settings“ dialog (Toolbars and Dialogs > View Settings).
To view the borders of the objects there are two possibilities in eCognition:

- Create polygons to view borders of objects ("Image Objects > Create Polygons..." or click ).

  To show or hide the polygons use the button. Since polygons use memory they should only be created if the results will be exported later-on in ESRI shape format.

- Use the button to show or hide outlines without creating polygons first.

In this case polygons are created for the visualization in the following.

Change the polygons’ color by clicking . Select black as the outlines’ color in the upcoming dialog.

This visualization helps you to check if the extracted image objects fit your purpose or not. If you now change the image data settings back to the pixel mode in the view settings, you can observe the object borders while still seeing the single pixels.

In comparison to a single pixel, an image object offers substantially more information. Move on to find out how to access it.
Obtaining information about image objects

The “Image Object Information” dialog provides detailed information about the selected image objects as to its features and classification. There is no classification information available yet, since you have not classified the image.

1. Open the image object information dialog by clicking the icon if it is not yet open.

2. Click an arbitrary image object.

This window gives you all the necessary information about one single object. When creating a class hierarchy, this dialog helps you to find features which separate one class from another. Another tool which helps you with this task is the feature view. The feature view allows you to display one feature for all image objects. The image objects are rendered in gray values which correspond to the feature value. The brighter an object is, the higher is its feature value for the selected feature.

3. From the “Tools” menu choose “Feature View...” or click .

4. Select the feature “Object features > Layer values > Ratio > dessert_blue.bmp” by double-clicking it. The objects will then be colored according to their feature value for the selected feature. A high gray value represents a high feature value, a low gray value a low feature value. You can visualize features also out of every other dialog where features are selected, for instance the “Insert Expression” dialog or the “Select displayed Feature” dialog. In this cases you open a pop up menu with a right click and select “Update range”.

![Image Object Information dialog]

![Feature View window]

3 - Take the Plunge
Loading a class hierarchy

Up to now, you have extracted image objects and learned how to call up information contained in them. This information will be used for classifying the previously segmented image objects. As this is an introductory tour of eCognition, an already existing class hierarchy will be loaded into the project for this purpose.

1. From the menu item “Classification” choose “Open Class Hierarchy...” or click ![Open Class Hierarchy](image1.png) in the tool bar. The “Class Hierarchy” editor is now open.

2. Select the item “Classification > Load Class Hierarchy...” in the menu bar.

3. Select the file “plunge.dkb” and open it.

At this point a crucial aspect of the knowledge base structure in eCognition will be introduced. As you can see above, there are two different registers within the class hierarchy dialog: “Inheritance” and “Groups”. Inheritance and groups define dependencies between classes concerning classification of image objects. They complement each other: while child classes inherit feature descriptions from their parent classes in the “Inheritance” register, the “Groups” register summarizes child classes in meaningful semantic groups. In this example there is no inheritance applied. Regarding the potential of groups, it becomes obvious that classes can be aggregated into groups with a superior meaning, resulting in a summarized land use classification rather than a mere land cover classification.

In the new class hierarchy displayed above you can see in the inheritance part, that all classes are at the same level, i.e. no class inherits from another class. This means from a physical point of view no class is similar to another. In the groups part you can see that they are sorted according to their meaning: woodland is a child class of vegetation which is a child class of not impervious. And waterbodies is also a child class of not impervious.

4. Open the class description of woodland in the hierarchy by double-clicking the class. Alternatively, you can click the class with the right mouse button and choose the item “Edit Class” in the following pop-up menu.

The “Class Description” dialog is now open. What you see is the feature description of the class woodland. It consists of a so-called standard nearest neighbor. Nearest neighbor is a classifier used to classify image objects based on given sample objects within a defined feature space. As you can see, this feature space consists here of the seven layer mean values (for the seven TM bands). The samples will be introduced in the following step. Click the other classes to see whether they contain the “Standard Nearest Neighbor” expression as well.

In contrast to the child classes, you will notice that the classes vegetation and not impervious are empty. This is because they are only used to aggregate the child classes into one set of common meaning.

5. Click “OK” to close the class description again.
Declaring sample objects

As already mentioned above, you will perform a classification using nearest neighbor. Training or test areas (TTA) can be imported into eCognition either by manually selecting them or by means of the a so-called TTA mask. In eCognition, image objects which function as samples for a nearest neighbor are referred to as samples or sample objects.

1. Choose “Load TTA Mask...” from the “Samples” menu.
2. Load the file “TTAMask_dessau.asc” as training and test areas mask.
3. Load the file “TTAMask_dessau.csv” as a conversion table.
4. Answer the question of whether you want to create classes from the conversion table with “No.”

The TTA mask is now shown in the view window.

5. Open the conversion table by selecting “Edit Conversion Table” in the “Samples” menu.
6. Select “Link by name” to automatically link the classes from the TTA mask to the classes of the class hierarchy and close the dialog.
7. Choose “Create Samples from TTA Mask” from the “Samples” menu.
8. Click “OK” in the following two dialogs.

You now have created a segmented image with the sample objects displayed in the respective class color.

9. To get a better view of the sample objects in contrast to all other image objects, you can change the color display of nonsample objects by opening the edit highlight colors dialog and changing the display mode for nonsample objects.
10. Select the menu item “Samples > Open Sample Editor...” or click in the tool bar.

The sample editor is now open. This is the central tool for working with sample objects. If there are no features displayed in the sample editor, first right-click in the sample editor window and choose “Select Features to Display” in the context menu. Then select the features to be displayed.

11. Select grassland in the “Active class” field.

Each of the small columns in the histograms represents the feature value of one or more samples. As a whole, the sample editor shows the feature signature of the class selected in the field “Active class.” The sample objects represented by the columns are the ones just created in the TTA mask.

Classifying image objects

After a number of sample objects have been declared as initial information for a nearest neighbor classification, you can start the classification process by clicking in the tool bar.

Once the classification process is finished, the result is shown in the view window.
You can obtain information about the classification of an image object by moving the mouse over it. A tool tip shows you the actual assignment value. Again, detailed information can be obtained in the image object information dialog. Click any image object to view its feature information as well as classification evaluation. There are three basic functions in the “Image Object Information” dialog:

The “Features” folder gives information about all the features of an object; the “Classification” folder contains information about the current classification of the object as well as its alternative assignments. The “Class Evaluation” folder gives detailed information about the evaluation of one class for one object.

Switch among the different folders to get an impression of the available information.

The classification result is displayed in the view window. Use the green arrows in the tool bar to navigate through the groups hierarchy and watch the classification results of the different aggregation levels. Simultaneously the displayed hierarchy collapses or spreads automatically according to the displayed aggregation level.

Move the mouse over an image object to obtain information about its classification, as explained earlier in this chapter.

The classification of the LANDSAT TM subset is now finished.

In this chapter you

- loaded raster data for multiresolution segmentation to create image objects,
- got an impression of how to obtain information transported by separate image objects and by the image as a whole,
- loaded a class hierarchy and became familiar with its structure and its purpose as the knowledge base in eCognition,
- declared sample objects to help you with your classification after editing them in the sample editor
- had a closer look at the class description, its structure and classifiers in order to subsequently familiarize yourself with editing classes and knowledge bases.

You have successfully worked your way through this introductory chapter of the user guide. Hopefully, the water was not too deep in this, your first experience of eCognition Elements, and you now feel compelled to delve deeper into eCognition’s world of object oriented image analysis!
4 GUIDED TOUR

The focus of this exercise lies on the use of multiscale information extracted from different image object levels which differ in resolution. The database is the same as used in the chapter “Take the Plunge.” The goal is to create a map which shows the landuse of the town of Dessau.

In this exercise you will learn how to:

• add and define classes using inheritence and the nearest neighbor classifier,
• take samples for the desired classes and find the best suited fetaure space to separate classes,
• create classes to group child classes meaningful,
• perform an accuracy assessment,
• export the classification result as a thematic layer.

This exercise will begin with the recovery of the classification created in the chapter “Take the Plunge.” As the same class hierarchy and identical samples are needed to achieve an identical classification result, the appropriate class hierarchy will be loaded along with the samples.

Loading raster layers

1. Start eCognition and choose “Project > New...” from the “Project” menu or click in the tool bar.

2. Open and sort the layers according to their spectral sequence and adjust the resolutions. The files are the same as in “Take the Plunge”. Right-click on the loaded channel to open the Layer Properties dialog. In the dialog set the resolution to 30m for the spectral channels and 120m for the thermal channel.

   Note: the image has no georeference and is already resampled to a common pixel size. Hence you can leave the checkbox “Geocoding” on or off. By switching the unit to meters the image size is recalculated. The image’s origin is still at 0/0 as long as you do not change it. Please bear in mind, that these settings can not be changed after you have created the project.

3. Click „Create“! Your image should like in the screen below.
Creating image objects

1. Choose “Multiresolution Segmentation...” from the “Segmentation” menu or click in the tool bar.

2. Edit the segmentation parameters as shown below. They are identical to those used in “Take the Plunge.”

Your view window should now display a segmented image which is identical to that in “Take the Plunge.” If necessary, adjust the view settings to “six layer mix” and “histogram”.

Loading the class hierarchy

1. Open the class hierarchy window by clicking the icon or selecting “Open Class Hierarchy...” from the “Classification” menu or the “Toolbars & Dialogs” menu.

2. Select “Load Class Hierarchy...” from the “Classification” menu (alternatively right-click in the “Class Hierarchy” dialog and choose “Load Class Hierarchy”).

3. Select “...\data\tour\dessau_start.dkb” as your class hierarchy file and open it.

The class hierarchy created in “Take the Plunge” has now been imported along with the identical samples into this project.

Classifying the image

To classify the image click .

In the pictures below, the classification of “Take the Plunge” has been recovered. Navigate through the hierarchy of semantic groups using the green arrows in the tool bar.
Editing the class hierarchy

The structure groups have already been defined in the imported class hierarchy. The following steps explain how to edit classes in the inheritance register.

1. Switch to the “Inheritance” register in the “Class Hierarchy” editor.

2. Create the classes meadow and crop and make them child classes of the parent class grassland. To do so select “Classification > Edit Classes > Insert Class” in the menu or right-click in the dialog box and select “Insert Class.” Then drag-and-drop the two classes into grassland. The two classes are now child classes of grassland and consequently inherit the description of grassland. You can check this by double-clicking on one of the child classes.

Declaring sample objects

Nearest neighbor classification in eCognition is similar to supervised classifications in common image analysis software. You have to declare training areas, which are typical representatives of a class. In eCognition such training areas are referred to as samples or sample objects.

1. To make identification of image objects easier, change the view from “Object mean” to “Pixel”, create polygons with the button. Simply click OK in the upcoming dialog and display the polygons by switching on the appropriate view setting or clicking .

2. Change the layer mixing as shown below.
4. Set the outlines color to black by clicking and changing the outlines color to black.

5. From the “Samples” menu select “Sample Editor...” or click in the tool bar.

6. The sample selection support will assist you in choosing well suited and separating samples for each class. Click the button.

7. Choose “Select Samples” from the “Samples” menu.

The sample editor displays five diagrams for feature values. The features are the mean values for each channel. Thus, the feature space displayed in the sample editor is identical to the standard nearest neighbor feature space. The “Active class” selection box in the upper left corner of the sample editor lets you choose the class you want to enter samples for. The sample feature values can be compared to those of another class by choosing a different class in the “Compared to” selection box.

8. Change the “Active class” to crop by selecting the class in the respective selection box or by clicking on the class in the “Class Hierarchy” editor.

9. Click a sample object for the class crop.

With a single-click, the sample editor marks the object’s values with red arrows for each feature. Simultaneously the content of the “Sample Selection Information” changes:

10. Mark the object as a sample object by double-clicking or SHFT-clicking on it in the image view.

The feature values of the sample object are now displayed by additional marks in the histograms.

11. Create further samples for crop.

When collecting samples, start in the first step with only one or a few samples for each class, covering the typical range of the class in the feature space, especially when it is heterogeneous. Otherwise, its heterogeneous character will not be fully considered. If a chosen sample is in feature space critically close to samples of other classes it is marked red in the “Sample Selection Information”. To locate critical samples in the image switch on the “Sample Navigation” by clicking . You become automatically navigated to the appropriate sample in the image view as well as in the “Sample Editor”. Use the blue arrows of the “Sample Navigation” bar to switch between a critical or a closest sample and the currently selected object. In the “Sample Editor” also the samples of the critical class are shown as the comparison class. To reselect the currently selected object, click on the gray marked sample in the “Sample Selection Information” and choose “Current”.

```
<table>
<thead>
<tr>
<th>Class</th>
<th>Membership</th>
<th>Min Dist</th>
<th>Mean Dist</th>
<th>Critical Samples</th>
<th>Number of Samples</th>
</tr>
</thead>
<tbody>
<tr>
<td>crop</td>
<td>0.673</td>
<td>0.924</td>
<td>4.972</td>
<td>3</td>
<td>14</td>
</tr>
<tr>
<td>meadow</td>
<td>0.645</td>
<td>1.703</td>
<td>6.352</td>
<td>0</td>
<td>14</td>
</tr>
<tr>
<td>impervious surface</td>
<td>0.125</td>
<td>0.118</td>
<td>10.152</td>
<td>0</td>
<td>7</td>
</tr>
<tr>
<td>waterbodies</td>
<td>0.637</td>
<td>10.169</td>
<td>17.333</td>
<td>0</td>
<td>5</td>
</tr>
</tbody>
</table>
```
Note that the distribution of a class does not need to be continuous when using a nearest neighbor classifier! This makes it, for instance, possible to summarize all different heterogeneous appearances of a class.

12. Repeat the declaration of samples for the remaining class meadow. Insert two or three sample objects for each class. Do not forget to select the appropriate class as active class.

Training areas for the nearest neighbor classification are determined by assigning sample objects to them. Now you can perform a classification based on nearest neighbor. The nearest neighbor has been inherited from grassland. This means grassland now has its old samples plus the samples of its child classes, but not vice versa. Consequently crop and meadows can be separated by their own samples. Additionally, you can look for a feature space which separates your desired classes at best.

Find a well suited feature space for your class descriptions

Since some classes are best described by their spectral features, others might be better described by their shape. And for some classes a combination of both might be best. eCognition Elements offers a variety of class describing features, which can all be combined in an arbitrary manner to span the feature space for a nearest neighbor classifier. Thereby, it is possible to have for each class an individual nearest neighbor classifier. To find out which feature combination might span the best feature space to distinguish your desired classes, you can use the “Feature Space Optimization”. All you need is to have classes and appropriate samples.

Start the “Feature Space Optimization” by clicking . The following dialog will come up:

In the left part you see the classes for which the Feature Space Optimization shall be calculated. By default all classes for which you have taken samples in the recent project are selected. To add or remove classes click “Select Classes” and make your choice in the upcoming dialog. In the right part you can create an initial feature space which shall be reduced to an optimum. For this example only choose the classes crop and meadow. Then click on “Select Features” and select the initial features.

For this example choose all spectral mean values without brightness, the channels’ standard deviations an ratios. Click OK after you have finished your choice. The initial feature space will be displayed in the Feature Space Optimization under “Features” (the right part).
Adjust the “Maximum dimension” to the “Number of selected features” (in this case 21). Doing so, all possible feature combinations will be taken into account for the optimisation. Then click “Calculate” to determine the best separating feature combination. Click on “Advanced” to get more information:

In this example the best separating feature combination consists of 8 different features (the blue marked). I.e. the initial feature space spaned by 21 features could be reduced to a dimension of 8 and the classes (represented by the samples) can be better separated using these features. If you click on “Show Distance Matrix” you can see how well the classes are separable.

Note: The resulting feature space is strongly dependent on your taken samples. Thus, taking different samples might lead to a different optimum feature combination.

Click on “Apply to Classes” to immediately create a nearest neighbor classifier for the chosen classes with this feature space.

Now once again check the class descriptions by double-clicking in the “Class Hierarchy” dialog on the classes crop and meadow. You will realize, that these classes now have two different nearest neighbor classifiers:
The first is the one you just created with the Feature Space Optimization. The second is the one which is inherited from grassland. Classify the image once again by clicking the button. You can enhance your classification results step by step if you take wrongly classified objects as further samples for your desired classes.

Now subdivide the class woodland by inserting two new child classes coniferous and deciduous. Apply the same strategy as for crop and meadow. This way you can enhance your classification in terms of becoming more and more detailed.

After you have realized a satisfying classification result you can sort the classes into meaningful groups:

Add further classes as groups:

To put a class into more than one groups as like crop in this example, use the right mouse button and drag-and-drop the class into the appropriate group(s). To decide which parent class is to be displayed while navigating upwards you can define this in the class description:
To navigate through the aggregation levels represented by the (parent) groups use the and buttons.

In some cases it is clear that only certain features could lead to a satisfying classification result. E.g. some classes could only be separated regarding their shape features, while their spectral features are similar or vice versa. In such cases you can determine the feature space of the nearest neighbor classifier by hand.

**Accuracy Assessment**

To perform an accuracy assessment you need some reference areas (ground truth data) which are stored in a TTA-Mask. Of course the reference areas have to be different from the areas you took as samples. Your TTA-Mask can be stored in different formats.

In this example load the the TTA-Mask TTAMask_Accuracy.asc and its appropriate ".csv file from the data folder: Select from the menu “Samples -> Load TTA-Mask ...” and select the files. Click “No” in the upcoming dialog. Then select from the menu “Tools -> Accuracy Assessment ...”. In the upcoming dialog switch the “Statistics type” to “Error Matrix based on TTA Mask” (default).

Now click on “Select classes” and select the following classes:
Click on OK to close the dialog. No click in the Accuracy Assessment dialog on “Show statistics” to display the error matrix:

In the matrix are several accuracy measurers displayed (read more in chapter XYZ in the User Guide). In general one can say: the closer the values are to 1.0 the better the classification result. In this example there were no samples for meadow in the TTA-Mask. This is the reason, why some values are 0 or undefined.

Exporting your classification

After a successful segmentation and classification the results can be exported in different formats. To export the results as polygons in vector format you can export them as ESRI Shape files. Besides there are several raster formats available. When exporting in raster formats according look-up tables are generated. To export your classification in raster format select from the menu entry “Export” > “Classification ... .”

Click on “Format” to choose a file format. You can enter a file name in the respective field. Then click on “Export ...” and navigate in the upcoming dialog to the folder where you want to save your classification.

Before exporting the objects as polygons make sure that you have created them already. To save your classification results in vector format as polygons choose from the menu “Export > Image Objects”.

This will export each object of the selected segmentation level as a polygon. If you choose “Raster” the shape of the polygons will follow the image raster. Using “Smoothed” will export them in a more abstracted form depending on the parameters you have entered during polygon creation. If you keep the settings at their default, the class name, class ID and the membership degree for each object will be exported. Additionally the color mixing values for each class are exported and the objects’ IDs. Click on “Preview” to check the exported attributes. To add more attributes click on “Select features” and make your choice. Click on “Export ...” to choose the folder where you
want to save your classification. If you do not want to export the class color and/or classification values switch off the appropriate check boxes.

**Summary**

In this exercise you

- created image objects,
- imported an existing class hierarchy,
- performed a classification based on samples,
- added new classes,
- optimized the feature space for your classes,
- performed an accuracy assessment,
- exported the results as raster or vector files.
5 USER INTERFACE

Overview

In this section of the user guide you will find detailed descriptions of the user interface.

List of eCognition dialogs:

- 2D Feature Space Plot .......................................................... 42
- Accuracy Assessment .......................................................... 42
- Apply Standard Nearest Neighbor to Classes ......................... 43
- Apply TTA Mask to Level ..................................................... 43
- Auto Cut Parameters ......................................................... 43
- Class Description ............................................................... 44
- Class Hierarchy .................................................................. 44
- Colors .............................................................................. 45
- Conversion Table ................................................................ 46
- Create Polygons ................................................................. 46
- Create Project .................................................................. 46
- Create TTA Mask from Level .............................................. 47
- Customize ......................................................................... 48
- Define Brightness .............................................................. 49
- Delete Classification .......................................................... 49
- Delete Level ...................................................................... 50
- Delete Samples of Selected Classes ..................................... 50
- Edit Layer Mixing ............................................................... 51
- Export Classification .......................................................... 52
- Export Image Objects .......................................................... 52
- Export Object Shapes ......................................................... 53
- Feature Space Optimization ............................................... 53
- Feature Statistics .............................................................. 55
- Feature View .................................................................... 55
- Help Keyboard .................................................................. 55
- Image Layer Histograms ...................................................... 56
- Image Object Information .................................................. 56
- Input Mode ........................................................................ 56
- Insert Expression .............................................................. 57
- Layer Properties ............................................................... 57
- Message Console .............................................................. 57
- Multiresolution Segmentation ............................................. 58
- Pan Window ..................................................................... 59
- Project Info ....................................................................... 59
- Sample Editor .................................................................. 59
- Sample Navigation ............................................................ 60
- Sample Selection Information ............................................ 60
- Scale Parameter Analysis ..................................................... 61
- Select Layer ..................................................................... 62
- Select Level ...................................................................... 62
- Select Displayed Features ................................................... 63
- Select Features for Statistic ................................................... 63
- Select ID Column ............................................................... 63
- Select Operator for Expression ............................................. 64
- Select Single Feature .......................................................... 64
- Set Nearest Neighbor Function Slope ................................... 64
- Statistics ........................................................................... 65
- Subset Selection ............................................................... 65
- System Info ....................................................................... 66
- User Information ............................................................... 66
- View Settings ................................................................... 66
Create new Project
Start a new project and load image layers and thematic layers.

Open Project
Open an existing project.

Save Project
Save project to disk.

User Information
Open the user information dialog.

Message Console
Open the "Message Console Dialog".

Multiresolution Segmentation
Open the "Multiresolution Segmentation" dialog and invoke segmentation.

Delete Level
Delete a level of the image object hierarchy.

Create/Modify Polygons
Create polygon outlines for image objects.

Delete Polygons
Delete polygon outlines of image objects.

Edit Class Hierarchy
Open the "Class Hierarchy" dialog.

Classification-Based Automatic Cut
Open the "Auto Cut Parameters" dialog.

Sample Editor
Open the "Sample Editor" dialog.

Image Object Information 1
Open the "Image Object Information 1" dialog.

Image Object Information 2
Open the "Image Object Information 2" dialog.

Sample Selection Information
Open the "Sample Selection Information" dialog.

Scale Parameter Analysis
Open the "Scale Parameter Analysis" dialog.

Feature View
Open the "Feature View" dialog.

Feature Space Optimization
Open the "Feature Space Optimization" dialog.

Input Mode
Change the input mode.

Classify
Invoke image object classification.

View Settings
Opens the "View Settings" dialog.

View Layer
Render current level using layer mean values of pixel.

View Classification
Render classification of current level.

View Samples
Render samples in current level.

Feature View
Switch back to feature view display.

View Pixel / Object Mean
Switch between pixel and object mean display.

Show/Hide Polygons
Display of computed polygon.

Show/Hide Outlines
Display of computed polygon outlines.

Edit Highlight Colors
Open the "Edit Highlight Colors" dialog.

Mix Single Layer Grayscale
Display image data in single layer grayscale format.

Mix Three Layers RGB
Display image data in three layer RGB format.

Show Previous Image Layer
Display the previous image layer.

Show Next Image Layer
Display the next image layer.

Select Level in Object Hierarchy
Select level in object hierarchy for processing.

Next Level down in Object Hierarchy
Go to next lower level in the hierarchy of image objects.

Next Level up in Object Hierarchy
Go to next higher level in the hierarchy of image objects.

Next Level down in Groups Hierarchy
Displays classes at next lower level in the groups hierarchy.

Next Level up in Groups Hierarchy
Displays classes at next higher level in the groups hierarchy.

Activate/deactivate sample navigation
Enables the navigation to samples selected in the "Sample Editor" or the "2D Feature Space Plot".

Normal Cursor
Switch from zoom or pan mode to normal cursor.

Area 100 %
Reset zoom factor to 100 %.

Zoom In
Zoom nearer.

Zoom Out
Zoom further out.

Area Zoom
Zoom into area.

Zoom In
Zoom in to center.

Zoom Out
Zoom out from center.

Pan
Pan current view.

Pan Window
Open Pan window.

Zoom Scene to Window
Zoom the scene to fit into the current window.

Polygon Selection
Select a polygon.

Line Selection
Select a line.

Rectangle Selection
Select a rectangle.

Image Object Cutting
Cut image objects.

Manual Image Object Classification
Classify an image object manually.

Image Object Fusion
Fuse selected objects.

Merge selected Objects
Merge selected objects to one object.

Clear Selection for Manual Object Fusion
Clear all selected object and do not merge objects.
Menu

Menu items in "Project":

New... Create a new eCognition project and load raster and thematic layers
Open... Open an existing eCognition project
Close Close the current project
Save Save the current project to disk
Save as... Save the current project to another file
Project Information... Display information about the currently loaded project
User Information Display information about the person currently locked on the machine
Add Image Layer... Load additional image layer to current project
Add Thematic Layer... Load additional thematic layer to current project
Assign layer alias Edit and assign aliases to the layers
Assign No Data Value Assign No Date Value
Exit Exit eCognition.

Menu items in "View":

Cursor Mode Open the View Settings dialog
Zoom In Center Zoom in at current view center
Zoom Out Center Zoom out at current view center
Zoom 100% Reset zoom factor to 100%.
Zoom to Window Zoom the scene to fit into the current window.
Edit Layer Mixing... Define a color composition for the display
Mix Single Layer Layer Grayscale DSet view settings to single layer mode
Mix Three Layers RGB Set view settings to three layer mode
Show Previous Image Layer Shifts the current view settings for one layer forward
Show Next Image Layer Shifts the current view settings for one layer backward
Edit Highlight Colors... Select highlight color settings and the display color of nonsample and unclassified objects.
Save View Settings Save the recent view settings for the next project
Copy Current View to Clipboard Copy the content of the current view to (in its recent settings) to the Clipboard
Menu items in “Image Objects”:

Multiresolution Segmentation... 
Open the “Multiresolution Segmentation” dialog and initiate segmentation.

Scale Parameter Analysis 
Open the “Scale Parameter Analysis” dialog to support the investigation of the scale parameter.

Export Scale Parameter Analysis 
Open the “Export Scale Parameter Analysis” dialog to export the results.

Create Polygons... 
Vectorizes objects of specified object level.

Delete Polygons... 
Delete polygons of selected level.

Classification-based object cut... 
Open dialog to select classes and parameters for the automated object cut.

Delete Level... 
Delete a level of the image object hierarchy.

Menu items in “Samples”:

Select Samples 
Select sample objects for the recently marked class.

Sample Editor 
Opens the Sample Editor.

Sample Editor Options 
Displays further sample functions in the sub-menu.

Delete Samples of Classes... 
Delete samples of selected classes.

Delete all Samples 
Delete all samples.

Create Samples from TTA Mask... 
Use a TTA mask to declare sample image objects.

Create TTA Mask from Samples... 
Create a TTA mask out of existing sample objects.

Load TTA Mask... 
Load TTA mask image and conversion table from disk.

Save TTA Mask... 
Save TTA mask layer and conversion table to disk.

Edit Conversion Table... 
Display and edit the conversion table.

Menu items in “Classification”:

Class Hierarchy 
Opens the “Class Hierarchy” dialog.

Edit Classes 
Functions to edit, insert and copy classes.

Sort Classes 
Functions to sort classes in the class hierarchy.

Advanced Settings 
Further settings for brightness layers and minimum membership values.

Nearest Neighbor 
“Edit Standard Nearest Neighbor Feature Space...” “Apply Standard NN to classes...” “Slope Function...”

Delete Classification 
Delete classification of all image objects.
Load Class Hierarchy... Load a Class Hierarchy from a file.

Save Class Hierarchy... Save class hierarchy to a file.

Delete Class Hierarchy... Delete the existing class hierarchy.

Menu items in "Tools":

- Feature View... Render the scene using a specific object feature.
- 2D Feature Space Plot... 2D plot of selected features.
- Image Layer Histograms... Shows the histograms of the scene.
- Feature Space Optimization... Opens the Features Space Optimization dialog.
- Scale Parameter Analysis... Open the Scale Parameter Analysis dialog.
- Statistics... Statistical evaluations of image object features.
- Accuracy Assessment... Statistical information on the actual classification.
- Manual Image Object Editing... Opens the sub-menu for the manual editing modes: normal selection, polygon, line, rectangular selection; image object cut manual classification and image object fusion.
- Options... Opens the Options dialog.

Menu items in "Tools > Input Mode":

- None... Default cursor functions.
- Select Samples... Use the cursor to pick samples.
- Manual Object Fusion... Use the cursor for merging image objects.
- Manual Classification... Use cursor to assign manual classifications to image objects.
- Manual Object Cut... Use cursor to define cut-line of selected object.

Menu items in "Export":

- Image Objects... Export image object level as a thematic layer (raster or vector format).
- Classification... Export classification of current image object level as image.
- Object Shapes... Export points, lines or polygons of objects belonging to a selected class.
- Current View... Copy current view to clipboard.
Menu items in "Toolbars & Dialogs":

All menu items open or close the specified dialogs.

Menu items in "Window":

New Window
Open a new scene window.

Cascade
Arranges the windows as overlapping tiles.

Tile Horizontally
Arranges the windows as nonoverlapping, horizontal tiles.

Tile Vertically
Arranges the windows as nonoverlapping, vertical tiles.

Link active Window
Synchronize the display area of other views with the active window.

Unlink active Window
Delete the display synchronization between the active window and another view.

Link all Windows
Synchronize the display area of all views.

Unlink all Windows
Delete the display synchronization between all views.

Menu items in "Help":

System Info...
Display system configuration and state information.

Test Hardlock
Open dialog “Test Hardlock” to check hardlock properties.

Keyboard Map
Overview of all eCognition short cuts.

Help
Open eCognition User Guide.

About...
Application info.
Dialogs

2D Feature Space Plot

This dialog box helps with checking the distribution of feature values over two different features.

To open this dialog choose the item “Tools > 2D Feature Space Plot...” from the menu bar of the main application window.

1. Select the image object level for which feature values are to be plotted.
2. Click here to select the feature to be plotted along the y-axis (see dialog below).
3. Click here to select the feature to be plotted along the x-axis (see dialog below).
4. Click here to select the classes for the feature space plot in their feature range.
5. This field displays the correlation (Pearson) between the values of the selected features.
6. In this field the mouse position in the feature space plot is displayed.
7. Name of the feature plotted along the y-axis.
8. Name of the feature plotted along the x-axis.
9. The colored circles show the selected samples (sample editor).
10. Navigate to the sample by clicking on it (Sample Navigation must be activated)

Select the feature to be plotted along the y-axis or x-axis in the following dialog by double-clicking or highlighting it and clicking “OK.”

Accuracy Assessment

This dialog box provides information about the classification quality.

To open this dialog box choose the item “Tools > Accuracy Assessment...” from the menu bar of the main application window.

1. Select the image object level to perform the accuracy assessment on.
2. Select the type of accuracy assessment.
3. This list shows the classes that are used for accuracy assessment.
4. Click here to edit the class list above (see User Interface > Select Classes).
1. Export file name of the statistic results.
2. Click this button to display the accuracy assessment results.
3. Click this button to save the accuracy assessment results to a file.

“Error Matrix based on TTA Mask”: Test areas are used as a reference to check classification quality by comparing the classification with ground truth based on pixels.

<table>
<thead>
<tr>
<th>Error Matrix based on TTA Mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>Total</td>
</tr>
</tbody>
</table>

"Error Matrix based on Samples": Similar to "Error Matrix based on TTA Mask" but considers samples (not pixels) derived from manual sample inputs. The match between the sample objects and the classification is expressed in parts of class samples.

<table>
<thead>
<tr>
<th>Error Matrix based on Samples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>Total</td>
</tr>
</tbody>
</table>

Apply Standard Nearest Neighbor to Classes

To open this dialog box choose the item “Classification > Nearest Neighbor > Apply Standard NN to Classes” from the menu bar of the main application window.

1. All available classes in the project. Single-click on class to switch to “Selected classes.”
2. All selected classes where the standard nearest neighbor will be applied. Single-click to deselect them.

Apply TTA Mask to Level

Choose in this dialog to which level a loaded TTA mask is to be applied.

To open this dialog box, choose the item “Samples > Create Samples from TTA Mask...” from the menu bar of the main application window.

Mark the image object level where the TTA mask is to be applied (no multiple selection possible).

Auto Cut Parameters

Use this dialog to cut-off outer parts of image objects, which consequently leads to a less complex geometry of the objects. Select the classes or objects you want to perform the automated cut on and choose the cut-off degree that determines the degree of branching to cut-off
To open this dialog, select the item “Image Objects > Classification-based object cut...” from the menu bar of the main application window.

**Note!** You have to create polygons before an automated object cut can be performed.

1. Enter the cut-off degree that determines the degree of branching to cut-off.
2. Select the classes to which the automated cut is to be performed on the corresponding image objects.
3. Carry out the automated cut.

### Class Description

This dialog box is used to create and edit a class description.

To open this dialog box, double-click on a class in the “Class Hierarchy: Inheritance” dialog or select the item “Classification > Edit Classes > Edit Class” from the menu bar of the main application window.

- **1** Displays the contained as well as the inherited part of the class description.
- **2** Displays only the contained part of the class description.
- **3** Displays only the inherited part of the class description.
- **1** Current name of the class.
- **2** Current color of the class.
- **3** Select the display parent group for navigating up the semantic groups hierarchy (right green arrow). This function is only necessary when a class belongs to multiple parent classes in the groups hierarchy.
- **4** Change class status to abstract. Abstract classes do not apply themselves to image objects directly. They only inherit or pass on their class descriptions to child classes.
- **5** Makes a class inactive. Inactive classes are ignored in the classification process.

### Class Hierarchy

This dialog box is used to create and edit a class hierarchy.

To open this dialog box either

- click the button on the tool bar of the main application window.
- choose between the items “Classification > Open Class Hierarchy...” and “Toolbars & Dialogs > Class Hierarchy” from the menu bar of the main application window.
- choose the items Image Objects > Classification-based Segmentation” or Image Objects > Edit Structure Groups...” from the menu bar of the main application window and automatically the dialog box with the register tab “Structure” is opened.
Displays the inheritance of the class hierarchy for the purpose of classification. Right-click for context menu. Drag a class with the left mouse button to move it. Drag a class with the right mouse button for multiple inheritance.

Displays the group structure of the class hierarchy for the purpose of classification. Use the right mouse button for context menu. Drag a class with the left mouse button to move it. Drag a class with the right mouse button for a multiple membership to more than one semantic group.

Menu items of the “context menu” (click right mouse button):

- **Edit Class**: Open the “Class Description” dialog of selected class.
- **Insert Class**: Create a new class and insert it into the class hierarchy.
- **Copy Class**: Copy selected class.
- **Delete Classification**: Delete the classification.
- **Select Color**: Choose a class in the class hierarchy and select the display color.
- **Active**: Activate/deactivate selected class. Inactive classes are ignored in the classification process.
- **Abstract**: Change to an abstract class. Abstract classes do not apply themselves to image objects directly. They only inherit their class descriptions.
- **Delete Class**: Delete selected class.
- **Delete Samples**: Delete Samples of the marked class.
- **Load Class Hierarchy**: Load a Class Hierarchy from file (*.dbk).
- **Save Class Hierarchy**: Save the current class hierarchy to file.
- **Delete Class Hierarchy**: Delete the current class hierarchy.

Colors

Use this color combo box to edit the color information of classes and all highlight colors.

To open this combo box check the color list item in the “Class Description” dialog or double-click in the left window of the “View Settings” dialog.

- **Pick a standard color in the color combo box. Click “Other” to get more predefined colors.**

- **Dialog to get more predefined standard colors. Choose Custom to define your own colors.**

- **Dialog to define your own color mixing for classes and highlight colors.**
Conversion Table

This dialog is used to display and edit the linkage between the classes of the project and the classes of a training and test area mask.

To open this dialog choose the item “Samples > Edit Conversion Table...” from the menu bar of the main application window.

1. This list displays how classes of the project are linked to classes of the training and test area mask. To edit the linkage between the TTA mask classes and the classes of your project right click on a TTA mask entry and connect it with the appropriate class in the project.

2. Click here to link all class names automatically by identical names.

3. Click here to unlink all classes.

Create Polygons

Use this dialog boxes to create polygons from the objects in the selected level.

To open this dialog box, choose the item “Image Objects > Create Polygons” from the menu bar of the main application window or select in the tool bar.

1. Edit the threshold for the generation of base polygons

2. Activate if sliver removal is desired

3. Edit the threshold for the generation of shape polygons

Create Project

Use this dialog to import and sort the image and thematic layers into the project, define a subset, and in addition edit the georeferenced information of the layers and their aliases.

To open this dialog, select the item ”Project > New...” from the menu bar of the main application window or click in the tool bar.

2. Project header information.

3. Displays the image layers selected for loading along with their properties.

4. Displays the thematic layers selected for loading together with their attribute tables.

5. Definition of image subset.

6. Clear subset definition.

7. Insert new image layers to the project.

8. Remove the selected image layers from the project.

9. Move the selected image layers up or down in the image layer order.

10. Sort image layers alphabetically. To do this mark which layers are to be sorted.

11. Insert a new thematic layer to the project.

12. Remove selected thematic layers from the project.

13. Move the selected thematic layers up and down in the thematic layer order.
Sort the selected thematic layers alphabetically.

Create the project. At least one image layer must be used.

Adjust the unit of the project

When loading a thematic layer from a multilayer image file (e.g. *.img stack file), the appropriate layer that corresponds with the thematic information is requested in the following dialog.

By right-clicking on a layer you can manually adjust its geocoding, resolution and alias name.

Create TTA Mask from Level

Choose in this dialog from which level a TTA Mask is to be created based on inserted samples.

To open this dialog box, choose the item “Samples > Create TTA Mask from Samples...” from the menu bar of the main application window.

Mark the image object level from where the TTA Mask is to be created (no multiple selection possible).
Customize

This menu enables customization and reset of toolbars, keyboard shortcuts and menus.

The “Customize” menu enables a moving of toolbar buttons by “drag and drop.”

1. All menu bar categories.
2. All eCognition commands which can be dragged into the toolbar by holding down the left mouse button.

3. All toolbars can be switched on and off.
4. The changes for the activated toolbar are set to default settings.
5. All changes in all toolbars are set to default settings.

6. Categories of the menu bar.
7. Set shortcuts for the default appearance of eCognition. No other selection is possible.
8. All eCognition commands in the selected menu bar category. An accelerator key can be assigned for the activated command.

9. Display the current accelerator key(s).
10. Display the newly assigned shortcut. Changes can only be made if the cursor is positioned in this field.
11. Click here to assign the new accelerator key to the eCognition command.
12. Click here to remove the accelerator key from the eCognition command.
13. Click here to reset all accelerator keys to default values.

14. “Default Menu” entry not yet used. Please use the “eCognition” menu bar entry.
15. Click here to reset all items in the menu bar.
16. Set desired menu animations
17. Activate for menu shadows
Activate/deactivate tool tip display.

Activate/deactivate shortcut key display in tool tips.

Activate to display large toolbar icons.

Activate for Windows 2000 look

Define Brightness

Use this dialog box to select those image layers from which the brightness is to be calculated.

To open this dialog box, choose the item “Classification > Advanced Settings > Select Image Layers for Brightness” from the menu bar of the main application window.

Mark image layers. The brightness will be calculated using the marked image layers only.

Delete Classification

Use this dialog to delete the classification of all image objects or of specified image objects.

To open this dialog box choose “Classification > Delete Classification” from the menu bar of the main application window.

Deletes the classification of specified classes; to select the classes, click “Select class” (see dialog below).

Delete the classification of a selected level.

Decide whether only the manual and/or the classification based on your rule base is to be deleted.

Deletes the classification of the specified image objects.
In this dialog you can select specific classes for which the classification is to be deleted:

1. This list displays all available classes where the classification will not be deleted. Single-click a feature to select it.
2. This list displays the selected features where the classification is to be deleted. Single-click a feature to deselect it.

**Delete Level**

Use this dialog box to delete one or more level.

To open this dialog box, choose the item “Image Objects > Delete Level(s)” from the menu bar of the main application window.

Mark the image level(s) to be deleted (no multiple selection possible).

**Delete Samples of Selected Classes**

In this dialog box select the classes for which samples are to be deleted.

To open this dialog box choose the item “Samples > Delete Samples of Classes...” from the menu bar of the main application window.

1. All available classes in the project. Single-click on class to switch to “Selected classes.”
2. All selected classes of which the samples will be deleted. Single-click to deselect them.
3. Move all classes from or to the selection list

**Edit Highlight Colors**

This dialog enables the selection of highlight color settings and the display color of nonsample and unclassified objects.

This dialog can be activated by “View > Edit Highlight Colors...” from the main menu bar, by the button from the tool bar, or by double-clicking in the left window of the “View Settings” dialog.
Color of selected image objects.

Display color of computed polygon outlines.

Color of nonsample objects in the “Sample View” display mode.

Color of unclassified objects in “Classification View” display mode.

Click “All Views” or “Active View” to apply changes to either all open views or the active view only. Exit the dialog.

### Edit Layer Mixing

Use this dialog box to define a color composition for the display of image objects. It is possible to assign more than one layer to a color.

To open this dialog box either:

- click the button from the tool bar of the main application window.
- click the item “View > Layer Mixing” from the menu bar of the main application window.
- choose the dialog box “View setting” and double-click on the dialog window.

1. Name of the image layer(s).
2. Select layer(s) to be colored in red, green and blue on the screen.
3. Choose display-equalizing algorithm.
4. Insert desired equalization parameter.
5. Choose display layer mixing presets.
6. Shift between image layers.
7. Switch between immediate display update and display update by the „Apply” button.
8. Switch between channel weights and unweighted display of channels.
9. Activates a display update; only active if auto update switch is off.

### Edit Minimum Membership Value

The minimum membership defines the minimum value for the classification. If the membership value of a classified image object is lower than this value, the object remains unclassified.

To open this dialog box select “Classification > Advanced Settings > Minimum Membership Value...” from the main menu bar.

1. Minimum membership value for classification. All lower values are defined as unclassified.
Edit Standard Nearest Neighbor Feature Space

Use this dialog box to edit the standard nearest neighbor feature space.

To open this dialog box choose the item “Classification > Nearest Neighbor > Edit Standard NN Feature Space” from the menu bar of the main application window.

1. List of all selectable features for the standard nearest neighbor feature space. Double-click a feature to select it.

2. This list displays the selected features that form the standard nearest neighbor feature space. Double-click a feature to deselect it. Defaults are all mean values of the image layers.

Export Classification

This dialog box is used to export the classified image as a raster file (*.tif, *.img., *.asc).

To open this dialog box, select the item “Export > Classification...” from the menu bar of the main application window.

1. Select classified image object level to be exported.

2. Choose the file’s name.

3. Click to choose the file format for export. Default is TIFF format.

4. Click to export the classification.

Export Image Objects

This dialog box is used to export an image object level as a thematic raster layer or as an ArcView vector file (*.shp).

To open this dialog box, select the item “Export > Image Objects...” from the menu bar of the main application window.

1. Select image object level to be exported as thematic raster layer or as ArcView polygon shape file.

2. Check to add the classification of the image objects as an export attribute.

3. Check to add the image object color of the current view as an export attribute.
Click to add and remove features to/from the attribute list.

Display the selected features for export.

Check to export as ArcView polygon shape file.

Check to define geometry smoothing. Raster geometry exactly follows the image pixels, whereas smoothed geometry avoids single pixel steps.

Choose the export file name.

Preview the export attribute table on the screen.

Save the geometry and attribute information to the disk.

Export Object Shapes

This dialog box is used to export an image object level as a thematic raster layer or as an ArcView vector file (*.shp).

To open this dialog box, select the item “Export > Image Objects…” from the menu bar of the main application window.

Select the image object level where the classes to be exported are situated.

Choose the format whether to export polygons, points or lines. For the geometry of the polygons check either “Polygon (raster)” or “Polygon (smoothed)”. As an additional feature you can choose auto abstraction for smoothed polygons. This yields a very high degree of abstraction that should produce very smooth borders (for instance to get roofs with only four edges).

The default name Image Objects could be changed here. The results are stored in the directory where the project is saved.

Use this button to add or remove classes to be exported. The selected classes are displayed in the right area of the window that pops up. The available classes are displayed in the left area. They can be added and removed by a right click with the left mouse button. With a right click it is possible to select a parent class including all child classes.

Use this button to add or remove features from the attribute list. The selected features are displayed in the right area of the window that pops up. The available features are displayed in the left area.

A preview of the attribute table that is exported can be requested by choosing the “Preview” button.

Choose “Export” to save the geometry and the attribute information to the disk. Select the main line’s center point or the object’s center of gravity to export.

Feature Space Optimization

With this dialog you control the feature space optimization.

To open this dialog box click the button from the toolbar of the main application window.

Select the classes for which you want to calculate the optimal feature space.

Create the initial feature space to be reduced.

Select a subset of the initial feature space by clicking single features.

Select the image object level of concern.

Enter the maximum dimension of the optimized feature space.
Click this button to generate feature combinations and their distance matrices.

Click this button to display the distance matrix of the currently selected feature combination.

Shows the largest distance between the closest samples of classes within the best separating feature space.

Shows the dimension of the best separating feature space.

Click this button to display advanced information about the results.

**Class Separation Distance Matrix For Selected Features**

This matrix shows the distances between samples of the selected classes within a selected feature space.

![Class Separation Distance Matrix](image)

**Advanced**

This dialog shows advanced information about all feature combinations and their separability of the classes' samples.

1. Select a feature space.

2. Shows the calculated maximum distances of the closest samples along the dimensions of the feature spaces. The blue dot marks the currently selected feature space. Click another dot to show other feature combinations.

3. Click this button to display the distance matrix of the currently selected feature combination.

4. Click this button to use the currently selected feature space for the standard nearest neighbor classifier.

5. Click this button to generate a nearest neighbor classifier using the current feature space for selectable classes.

6. Check this box to automatically classify the project when pressing “Apply to Std.NN.” or “Apply to Classes”.

**Class Separation Distance Matrix**

This matrix shows the distances between samples of the selected classes within a selected feature space within the dialog “Feature Space Optimization - Advanced Information”. Select a feature combination and re-calculate the according distance matrix.

![Class Separation Distance Matrix](image)
Feature Statistics

This dialog box displays the classification accuracy, feature statistics and object attributes in matrix form.

The dialog box is opened via the following dialogs:

• “Tools > Accuracy Assessment > Show statistics”
• “Tools > Statistics… > Show statistics”
• “Export > Image Objects > Preview”

1 Attributes and statistics are here displayed in matrix form.
2 Reduce column width to minimum.
3 Enlarge column width to display complete column captions.

Feature View

This dialog box is used to determine the display of features in the main view.

To open this dialog choose either

• “Tools > Feature View” or “Toolbars & Dialogs > Feature View” from the menu bar, or
• press the button in the toolbar.

1 Choose an image object feature for display with a double-click or use the right mouse button and select „Update Range“ from the popup-menu. While „Update Range“ adapts the active feature range to the selected feature, a double-click only selects the new feature without an update of the range.
2 Check to edit the display of the feature range. All image objects whose values are within the range are colored according to the adjusted range in a smooth transition from blue (low values) to green (high values)
3 Minimum value of the feature range display.
4 Use the arrows to change the minimum feature value for display.
5 Maximum value of the feature range display.
6 Use the arrows to change the maximum feature value for display.

Note! It is not necessary to open the “Feature View” dialog to visualize a feature. In each dialog you use to select features, like “Insert Expression” or “Select Displayed Feature”, you select the feature you want to display with a right click and choose “Update Range”.

Help Keyboard

This menu gives an overview of all eCognition default accelerator keys and user defined short cuts. To edit the short cuts, use the “Customize” menu in the “Toolbars & Dialogs” menu of the menu bar.

1 Command category of the menu bar items.
2 Switch between default program accelerator keys and user defined short cuts in eCognition.
3 Overview of all defined short cuts.
**Image Layer Histograms**

This dialog provides information about the distribution of grey values in single image layers.

To open this dialog choose the item “Tools > Layer Histograms...” from the menu bar of the main application window.

1. With the left and right spinners switch to next/previous image layer.
2. Name of the current image layer.
3. This field provides statistical information about the grey value distribution of the current image layer.

**Image Object Information**

This dialog box provides detailed information about the features and classification of an image object.

Both dialog boxes (“Image Object Information” and “Image Object Information 2”) have the same functionality and layout. With these two dialog boxes you can examine features, class description and class evaluation at the same time. To open this dockable dialog box click the buttons or in the toolbar or open the item “Toolbar & Dialogs > Image Object Information / Image Object Information 2” in the menu bar of the main application window.

A. Shows feature values of a selected image object. To change the display feature list, right-click in the dialog and choose the features to be displayed in the list.

B. Displays the result of the last classification of the image object. The three best classification results are stored and displayed. Alternative assignments can differ from the current classification due to changes in the membership functions since the last classification run.

C. Displays detailed classification evaluation for the selected class. Double-click an item to edit its membership function.

1. Click the register tab to open the dialog „Features“, „Classification“, or „Class Evaluation.“

**Input Mode**

Use this menu item to select samples, manually fuse image objects, perform manual class assignments for image objects, or cut objects by manually. The input mode does not change automatically if the “Sample Editor” or the “Manual Fusion” button are activated.

To open this menu item either

- choose the drop-down menu “Input Mode” from the menu bar of the main application window and choose the input mode.
- choose the combo box “Input Mode” from the tool bar and choose the desired input mode.
**Insert Expression**

This dialog box is used to choose and insert an expression into a class description.

Open it by right-clicking the logical term in the class description and choose “Insert new Expression” from the context menu or by double-clicking on the logical expression.

1. Select the desired expression by navigating through the hierarchy of features. To insert the expression, double-click it or mark it and click the “Insert” button.
2. When this box is checked the selected expression will be inverted (1 – assignment value) and linked with a “not” expression.
3. Insert the selected expression into the class description.

**Layer Properties**

Use this dialog box to check and edit the georeferencing information of the imported image layers and thematic layers. You can also assign an alias for the chosen layer in this dialog. Generally, the georeference data can only be edited at the beginning of a new project. After creating the project, no changes can be made.

To open this dialog move the mouse into the dialog “Import Raster Layers: Create Project” and right-click or double-click in the window of the imported image or thematic layers.

1. The name of the imported image layer or thematic layer in which the geocoding is to be edited.
2. X-coordinate of the lower left corner of the image.
3. Y-coordinate of the lower left corner of the image.
4. Geometric resolution.
5. If deactivated, geocoding of the specified layer is ignored.
6. Assign a new alias here.

**Message Console**

This dialog provides information about warnings or other messages from eCognition concerning the workflow in your project. The message console will automatically come up whenever an operation cannot be executed. Warning messages are shown in yellow; messages that need user interactions are marked in grey. Hint messages are shown in green and error messages that immediately stop the execution of eCognition are shown in red.

To open this dialog press the button from the tool bar of the main application window.
In the left column is shown the eCognition environment which prompted the message. The right column shows the output message and - if present - the user’s interaction with the dialog.

You can clear the console by right clicking on it and selecting “Clean Console”.

**Multiresolution Segmentation**

This dialog box is used to edit the parameters for eCognition’s multiresolution segmentation.

To open this dialog box select the item “Image Objects > Multiresolution Segmentation...” from the menu bar of the main application window or click ![icon](image) in the tool bar.

1. Displays image layers in the scene and their weights for segmentation. The weights are internally standardized to 1.

2. Displays thematic layers in the scene and whether they are used or not in the segmentation process. This register tab is only available if a thematic layer has been loaded into the project.

3. Select the level in the image object hierarchy on which the segmentation will be performed.

4. Use this field to define the layer weight for the selected image layers. Choose 0 to deactivate the use of a thematic layer during segmentation.

5. Use the scale parameter to define the resolution of the image object level. Increase the value to create larger image objects. The scale parameter refers exclusively to the weights of the image layers (weight * scale parameter).

6. Select the desired segmentation algorithm (in most cases “Normal”).

7. Weight color homogeneity against form homogeneity here. The sum of the weights is 1. Edit the value for color or shape. The counterpart is fitted automatically.

8. Use smoothness and compactness to define how shape homogeneity is described. Increase smoothness to achieve smoother edges of image objects, increase compactness to create image objects of a more compact form.

9. If you activate this box, an existing selected image object level will be removed and replaced by the new one.

10. Enable diagonal 8-pixel neighborhood instead of default 4-pixel neighborhood.

11. Use obsolete segmentation method of eCognition version 2.1 and lower to create image objects.

12. Start the segmentation with current settings.

13. Select if the multiresolution segmentation shall refer to layer aliases.

14. Perform multiresolution segmentation only on objects within structure groups of the level above or below.
Pan Window

The “Pan Window” is used to navigate in large data sets to allow smooth data handling. To open this dockable dialog box, click the item “Toolbars & Dialogs > Open Pan Window” from the menu bar of the main application window or click the button from the toolbar.

1. This field shows the area which has been chosen for panning. Drag the frame with the right mouse button to navigate in the image.

Project Info

This dialog box provides information about the project data and size, and the geocoding header information.

To open this dialog, choose “Project > Project Information” from the menu bar of the main application window.

Sample Editor

Use the “Sample Editor” to compare image object and sample histograms, to view the range of the image and sample histograms and to compare with other classes.

To open this dockable dialog box choose the item “Samples > Open Sample Editor...” from the menu bar or click in the tool bar and change the input mode in the menu bar and combo box.

1. Select the class for which you want to edit or collect sample objects.
2. Select a class for comparison with the active class.

Menu items in the context menu “Sample Editor”:

- **Select Features for Display...**
  - Select features for display in the “Sample Editor” dialog.
  - All image object features can be used (form and texture also).

- **Generate Membership Functions**
  - See below.

- **Display Membership Functions**
  - Switch between display of automatically computed membership functions and no display.

- **Display entire Feature Range**
  - Switch display between whole feature range and sample feature range.

- **Display Axis Labels**
  - Switch on or off axis labels.
Display Samples from Inherited Classes
   Shows also samples from sub-classes if there are any.

Activate Sample Navigation
   Activates the sample navigation mode. By clicking on a slot
   you become navigated automatically to the first sample of the slot.

Display Samples from Inherited Classes
   Shows also samples from sub-classes if there are any.

Activate Sample Navigation
   Activates the sample navigation mode. By clicking on a slot
   you become navigated automatically to the first sample of the slot.

Menu items in context menu “Generate Membership Function”:

Compute
   Automatic calculation of membership function from a selected sample feature.

Edit / Insert
   Edit or insert a membership function manually.

Delete
   Delete the membership function of the selected feature.

Sample Navigation

Use „Sample Navigation“ to navigate to samples selected in the „Sample Editor“ or the „2D Feature Space Plot“ with a single click
on the corresponding sample.

To activate the sample navigation click the button. Once a sample
is selected the view navigates to the corresponding sample that will be
highlighted in the image view. If in the “Sample Editor” or in the “2D
Feature Space Plot” there are two or more samples so close together
that it is not possible to select them separately in these dialogs, it is
possible to switch between the samples with the blue arrows or the pull-down menu.

Sample Selection Information

If samples were already selected for the corresponding classes you can assess the quality of a new sample with the „Sample Selection Infor-
mation“ dialog. This way it is easier to decide if an object contains new information for the description of a class, or if it rather belongs to
another class.

<table>
<thead>
<tr>
<th>Sample Selection Information</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>Impermeable surface</td>
<td>0.710</td>
<td>1.063</td>
<td>70.552</td>
<td>1</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>Agriculture</td>
<td>0.051</td>
<td>1.945</td>
<td>10.078</td>
<td>0</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>Water</td>
<td>0.019</td>
<td>1.395</td>
<td>16.422</td>
<td>0</td>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>

1 „Class” describes the name of the class to which the values in the row belong to.
2 „Membership” shows the membership value of the nearest neighbor classifier for the selected object.
3 „Minimum Dist.” shows the distance in feature space to the closest sample of the appropriate class.
4 „Mean Dist.” shows the average distance to all samples of the concerned class.
5 „Critical Samples” shows the number of samples that are in a critical distance to the selected class in the feature space.
6 „Number of samples” shows the number of samples selected for the corresponding class.
In the first line all values for the selected are class colored in yellow. All classes to which the selected sample is situated in a critical distance are red. All other classes that are not in a critical relation are colored green.

It is possible to change the critical sample membership value with a right click in the window. Select “Modify critical sample membership overlap” from the pop-up menu. The default value is 0.7, which means all membership values higher than 0.7 are critical.

It is also possible to select the classes you want to display. In this case right click in the dialog and choose “Select classes to display” from the pop-up menu.

**Scale Parameter Analysis**

With this dialog you control the scale parameter analysis.

To open this dialog box select the item “Image Objects > Scale Parameter Analysis ...” from the menu bar of the main application window or click in the tool bar.

- **A** Displays image layers in the scene and their weights for segmentation. The weights are internally standardized to 1.
- **B** Set displays settings for visualization of merging scale parameters. The settings are only applicable, if there are polygons present.
- **C** Select the level in the image object hierarchy on which the analysis is to be performed.
- **1** Use this field to define the layer weight for the selected image layers. Choose 0 to deactivate the use of a layer during analysis.
- **2** Select the desired segmentation algorithm (in most cases “Normal”).
- **3** Weight color homogeneity against form homogeneity here. The sum of the weights is 1. Edit the value for color or shape. The counterpart is fitted automatically.
- **4** Use smoothness and compactness to define how shape homogeneity is described. Increase smoothness to achieve smoother edges of image objects, increase compactness to create image objects of a more compact form.
- **5** Calculates the scale parameters with current settings.
- **6** Shows statistics of calculated scale parameters.
- **7** Exports the statistics.
"Scale Parameter Analysis - Statistics"

This dialog gives information about the statistics of the potential scale parameters for all object pairs.

1. Shows the statistical parameters: Number of scale parameters, minimum value, maximum value, mean value, variance of values, the standard deviation and the modal of the most frequently occurring value range.

2. Shows the distribution of potential scale parameter values. Click on a slot of the histogram to see the slots value range and the frequency of this value range.

3. Shows the range of the currently selected slot.

4. Shows the frequency of entries in the currently selected slot.

Select Layer

This dialog box pops up every time you have to select image layers, e.g., when you want to create a new project, or load an additional image or thematic layer into the project.

1. To select a new layer mark the file name and click “Open.” It is also possible to select multiple files at once.

Select Level

This dialog box pops up every time you have to make a selection of image object levels, e.g., when you want to delete an image object level or create a training and test area mask from an image object level or create polygons starting from a base level.

1. To select a level mark it and click “OK.”
Select Displayed Features

Use this dialog box to make a selection of one or more features for display of feature values in the image object information dialog. Open the dialog by right-clicking in the dialog “Image Object Information”, register tab “Features.”

1. This is the list of all selectable features. Double-click a feature to select it.
2. This list displays the selected features. Double-click a feature to deselect it.

Select Features for Statistic

Use this dialog box to make a selection of one or more features for the purpose of display of feature values, statistical analysis or export.

1. This is the list of all selectable features. Double-click a feature to select it.
2. This list displays the selected features. Double-click a feature to deselect it.

Select ID Column

If you import a thematic layer into your project and eCognition does not find an appropriate column with the caption ID in the respective attribute table, use this dialog box to determine the column containing the polygon IDs.

Select the caption of the column containing the polygon ID from this drop-down menu.
Select Operator for Expression

Use this dialog box to edit a logical operator in the “Class Description.”

Right-click on a logical expression in the class description and choose the item “Edit Expression” in the context menu.

List of all available logical operators. To select an operator, mark it and click “OK.”

Select Single Feature

Use this dialog to select a single feature from the feature list.

This dialog is opened when you have to select a single feature, e.g., “2D Feature Space Plot” or if a new expression should be included in the class description.

To select a feature from this feature list, double-click it or mark it and click “OK.”

Set Nearest Neighbor Function Slope

The basic effect of the function slope is to increase or decrease the distance an object may have from the nearest sample in feature space while still being classified.

Degree of membership function at the distance of 1 from image object to sample object. Larger values result in more classified objects.
Statistics

Use this dialog box to calculate statistics of classes using the image object features.

To open the dialog box choose the item “Tools > Statistics...” from the menu bar of the main application window.

1. Select the image object level for which the statistics have to be calculated.
2. Select the statistics type.
3. Check these buttons to select the operations that will be performed on the feature values.
4. This field lists the classes for which feature statistics will be calculated.
5. Click here to edit the class list above.
6. This field lists the features used for the calculation of statistics.
7. Click here to edit the feature list above.
8. In this field write the name of your statistics export file.
9. Click this button to display the statistics.
10. Click this button to save the statistics to an ASCII file.

Subset Selection

This dialog enables the graphical and numerical selection of image subsets. Only during project creation can this subset definition be made. To invoke this dialog chose “Subset selection” in the “Import Raster Layer: Create Project” dialog.

1. Display the image and graphical subset selection by clicking and holding the left mouse button at the upper left corner of the subset and dragging to the lower right corner of the subset.
2. Minimum X value of subset.
3. Maximum X value of subset.
4. Minimum Y value of subset.
5. Maximum Y value of subset.
6. Resolution of active image layer.
7. Scene size of subset in X direction.
8. Scene size of subset in Y direction.
9. Name of the active image layer.
10. Check to use geocoded coordinates.
11. Check to store the subset in an own file.
System Info

This dialog box provides information about the hardware and software status of the computer system.

To open this dialog choose “Help > System Info...” from the menu bar.

1. This field provides information about the hardware and software of your system.

2. Edit the folder for storing temporary files. This can only be done before loading any data.

User Information

This dialog box provides information about the current user, company and copyright.

To open this dialog choose “Project > User Information” from the menu bar.

View Settings

This dialog box is eCognition’s central visualization tool.

To open this dockable dialog box either

- click the button ![dialog button](image) from the tool bar.
- choose the item “Toolbar & Dialogs > View Settings” in the menu bar of the main application window.

1. Select the view mode with right-click on “Mode”. Choose among: “Layer, Samples, Classification, Classification Stability, Best Classification Result.”

2. Select layer with right-click on “Layer.” Choose among “Image Data, TTA Mask and Thematic Layer.”

3. Select image data. Switch between “Object mean and Pixel.”

4. Before displaying outlines you have to create polygons first. Select the outline display. Choose between outlines (raster/smoothed) or no outlines.

5. Color display-equalizing mode (Double-click to change values in the “Edit Layer Mixing” dialog).

Layer color mixing (Double-click to change values in the “Edit Layer Mixing” dialog).

Double-click: opens dialog “Edit Highlight Colors”.

Double-click: opens dialog “Edit Layer Mixing”.
